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1 Introduction

Thank you for purchasing your Vi-PEC Plug-In Engine Control Unit (ECU).  Vi-PEC VX
ECUs are an advanced, fully programmable microprocessor controlled Engine Management
System.  

The VX software platform boasts an impressive list of features giving a new level of user
adjustment.  This flexibility allows the tuner to have complete control over the engine
management system.   VX software employs high resolution fuel and ignition tables with
configurable load and RPM centres.  When coupled with up to six dimensional fuel and
ignition mapping, barometric pressure compensation and intake air temperature correction
this gives an unprecedented level of tuning accuracy.  All Vi-PEC VX ECUs are in field
upgradeable, there is no need to return the unit for software updates.

All Vi-PEC VX Plug-In Engine Management Systems are designed with flexibility and ease
of installation in mind.  Vi-PEC Plug-In systems are deigned to replace the circuit board
inside the factory ECU enclosure.  This provides an invisible install that requires minimal
modification to vehicle wiring and ECU mounting.

Vi-PEC Engine Management Systems are designed with the final result in mind.  Not only do
they boast an impressive range of performance features, but are designed with a focus on
safety, reliability and drive-ability.  However, the ultimate success of your engine
management upgrade is determined by how well the system is installed and tuned.

Installing and tuning any after market engine management system is not to be taken lightly.  
VX ECUs give the tuner the control & flexibility that only top after-market engine
management systems in the world can provide.  While every effort has been made to keep 
VX ECUs as user friendly as possible, it should be recognised that added features bring
added complexity.

The complete setup of your ECU can be divided into two  important tasks:

1. This manual covers the installation of your VX ECU.  While it is not strictly essential that
this work is performed by an automotive electrician, the knowledge and tools available to
these professionals makes it highly recommended. Regardless of who does  the
installation, it is of utmost importance that instructions provided in this manual are
followed exactly throughout the installation.

2. Once the VX ECU has been installed it will need to be tuned using a laptop computer
with Vi-PEC Tuning Software software.  Information on the configuration and tuning of
the VX ECU is detailed in the online help section of Vi-PEC Tuning Software.  VX ECUs
are shipped pre-loaded with a base  configuration that should be close enough to get
most engines running after a few application specific adjustments have been made. 
While hearing the engine running on the new ECU for the first time is always a satisfying
feeling, it is important to realise that the job is not complete.  The amount of tuning
performed and the experience of the tuner are the two most important factors in
determining how happy you will be with your engine management system.

1.1 Safety Notice

Your Vi-PEC Plug-In ECU is designed to enhance the performance of your vehicle.
However in all cases, your vehicle must be operated in a safe manner.  Do not tune your
vehicle while operating it on public roads.  Obey road rules at all times.
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WARNING!

Failure to follow all installation and operating instructions may result
in damage to the Vi-PEC ECU, personal injury, or harm to property.

1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the
vehicles wiring harness are correct.  However due to variations between vehicle models it is
the installers responsibility to check wiring connections BEFORE installing the ECU.  Vi-PEC
will not be held responsible for any damage caused by the incorrect installation of this
product.

1.3 Support Options

Should any issues arise during installation, the following options exist for technical support:

1. Vi-PEC Tuning Software help, press F1 while running Vi-PEC Tuning Software

2. Contact your nearest Vi-PEC dealer.  A Vi-PEC dealer list is available on our website.

3. Vi-PEC website:  www.ViPEC.com

4. Technical Support Email:  tech@ViPEC.com

5. Online Discussion Board: Available from the Vi-PEC website.

The majority of questions received by the technical support team are  clearly answered in
the manuals.  To speed up your technical inquiry please consult the manuals to make sure
that your question has not already been answered.
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2 Pre-Installation

Before installing theVi-PEC VX ECU into the vehicle some pre-installation checks must be
performed. 

2.1 Board Switch Settings

Some Vi-PEC VX ECUs require switches on the board to be set before installation.

2.1.1 Mitsubishi Lancer Evolution IV-VIII

The location of the intercooler spray relay pin changed between models.  Set the provided
jumper in the correct location for your model.

2.2 Injector Impedance

Injector impedance is important and needs consideration before installing the ECU.

2.2.1 Mitsubishi ECUs

The Mitsubishi VX Plug-In ECU is NOT designed to be used directly with low
impedance injectors.

All models this ECU is designed for are fitted with low impedance injectors from factory. 
Current through low impedance injectors is reduced by the use of factory fitted injector
ballast resisters.    This means that the ECU is plug-in compatible with factory fitted injector
combinations on all models.  DO NOT remove the factory fitted ballast resisters.
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3 Installation

This guide provides information on correctly and safely installing your new Vi-PEC VX Plug-
In ECU.

3.1 ECU Handling Procedures

WARNING!!!

The following installation process will require handling of both the Vi-
PEC ECU and factory ECU. Both of these are highly sensitive to

electrostatic discharge and are easily damaged. Follow the anti-static
precautions given in this manual carefully to avoid damaging

electronic components. Warranty claims for ECUs damaged by
electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can
reach very high voltages. Whenever given the opportunity this energy will

attempt to discharge (usually through your finger tips!). This can be fatal to most
electronic components. Most people have experienced an electrostatic
discharge when they step out of their car or touch a metal bench top. 

1. The following guidelines describe precautions that can be taken to reduce the
possibility of damaging your ECU:

2. Work only on a conductive surface. A clean steel bench is suitable.

3. Always wear a wrist strap that is electrically connected to the conductive
working surface.

4. Touch the working surface regularly.

5. Do NOT touch components on the circuit board.

6. Where possible, only handle the ECU by its plastic header.

7. Do NOT carry the ECU around without anti-static packaging. 

8. Do NOT touch the bare terminals in the ECU header.

Observing the above procedures will minimise the chance of damaging the
ECU. Note that failure due to static damage often does not appear until well

after it was caused.



PlugIn Installation Manual8

© 2009 Vi-PEC

3.2 Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.

3.2.1 Fitting a Mitsubishi ECU

The following steps outline the installation procedure:

1. Remove the factory ECU from the vehicle:  Ensure the key is in the OFF position.  The
factory ECU is located on the left A pillar about 30cm above the floor.  Unplug the wiring
harness from the factory ECU.  Remove the 6mm bolts (10mm socket) that retain the
ECU and remove the ECU from the vehicle. DO NOT touch the exposed pins in the
factory ECU connector.

2. Remove the factory ECUs circuit board from its enclosure:  Ensure you are following the
given anti-static guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP
connected to a conductive working surface.  Using four small flat bladed screwdrivers,
carefully pry apart the four plastic lugs retaining the ECUs header plate into the case. 
Some force may be required to remove the circuit board from the case as it may be
partially glued to the inside.  Remove the circuit board by removing the retaining screws. 
Hold it only by the plastic header and place it aside.

3. Connect the ECU USB tuning cable and the expansion loom if required.

4. Fit the Vi-PEC Plug-In ECU, there are several options depending on the vehicle:

· EVO IV to VIII -  If fitting to a short case, CAREFULLY snap the PCB extension off.  It may
be necessary to use a sharp knife to first score the break off points.  Place the factory
ECU in the packaging your Vi-PEC ECU came in for its protection. Carefully fit the
supplied aluminium end plate to the enclosure. Make sure the end plate is fitted to allow
any cables to exit on the left side of the header.

· EVO IX - Place the factory ECU in the packaging your Vi-PEC ECU came in for its
protection. Carefully fit the supplied aluminium end plate to the enclosure.  Make sure the
end plate is fitted to allow any cables to exit on the left side of the header.

· All Others proceed to step 5

5. Install the Vi-PEC ECU circuit board into the enclosure, then fit the enclosure into the
vehicle.

6. Connect the ECU to the factory wiring loom. 

7. Do NOT attempt to start the vehicle.  Proceed to read through the remaining sections of
this manual first.
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4 Additional Sensors

VX Plug-In ECUs offer various options for the installation of additional sensors and devices.
As a minimum it is recommended that all ECUs are installed with a Manifold Absolute
Pressure (MAP) sensor and Intake Air Temperature (IAT) sensor.  These parts can be
purchased if required from your nearest Vi-PEC dealer. 

4.1 MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure
source after the throttle body.  It is common to 'T' into the fuel pressure regulators pressure
signal.  Do NOT share this signal with other devices such as boost gauges or blow off
valves.

4.1.1 Mitsubishi Lancer Evolution I - IX

The Vi-PEC VX EVO Plug-In ECU supports several options for fitting of a MAP sensor.   Any
one of the following options can be used:

1. On board MAP Sensor – The Vi-PEC EVO I-III Plug-In ECU is shipped with a MAP sensor
fitted to the ECUs base board.  This MAP sensor is suitable for up to 1.5 Bar of boost
(approx 22 PSI).  The on board MAP sensor is wired to An Volt 1.

2. MAP Through AFM – The factory AFM wiring can be used to install a MAP sensor.

EVO III AFM Pinout (looking into wire side of connector).

3. MAP Through Expansion Connector - The expansion connector provides power ground
and analog channels for the connection of a MAP sensor.

Make sure that the correct An Volt channel has been selected as MAP sensor in Vi-PEC
Tuning Software and a MAP calibration has been performed before attempting to start the
vehicle.

4.2 IAT Sensor

It is highly recommended that an IAT sensor be fitted in all applications to provide an input
for correction of fuel and ignition based on the engines air charge temperature.

An IAT sensor should be fitted in the intake system in a location that accurately represents
intake temperature.  The most common location is just prior to the throttle body.  Installing in
the manifold is not recommended due to heat soak issues.  A fast response sensor must be
used in all forced induction applications.

4.2.1 Mitsubishi Lancer Evolution IV - VIII

From factory, models supported by the Vi-PEC VX EVO IV-VIII Plug-In ECU are not fitted
with a suitable IAT sensor.  The Vi-PEC VX EVO IV-VIII Plug-In ECU supports several
options for fitting of an IAT sensor.   Any one of the following options can be used:
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1. IAT Through AFM – The factory AFM wiring can be used to install a MAP sensor.  An
Temp 2 is wired to the AFMs temperature sensor.  Refer to the MAP sensor wiring
information above.

2. IAT Through Expansion Connector - The expansion connector provides ground and
temperature channels for the connection of an IAT sensor.  Wire the sensor between the
Ground pin and an An Temp channel pin.  Note that not all ECU models have spare
temperature channels.

3. IAT Through Fuel Temperature Pin – Pin 77 is connected to An Temp 3.  On some
models this is used to measure fuel tank temperature.  You can wire an IAT sensor
between this pin and pin 92 (sensor ground).  Refer to Appendix B for pin numbering. 
Additional terminals to fit the factory header are supplied with the ECU.

4.3 Expansion Connector

The expansion connector is provided to allow easy connection of additional ECU inputs. An
“expansion cable” needs to be purchased from your Vi-PEC dealer. 

Important points when wiring to the expansion connector:

· Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V
out signal also provides power for other sensors.

· Do not connect the ground pin to chassis ground. This could cause ground loops and
introduce unnecessary interference. Use this pin only to ground external sensors that are
isolated from chassis ground.

4.3.1 Mitsubishi Lancer Evolution IV - VIII

The following expansion connector outputs are provided:

Gnd Sensor Ground Only 

+5V Out Low Current +5V Supply

DI7 Currently not connected

DI8 Currently not connected

An Volt 6 Analogue 0-5V input

An Volt 7 Analogue 0-5V input

An Temp 4 Currently not connected
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5 PC Tuning

VX ECUs require PC/laptop tuning using the Vi-PEC Tuning Software Tuning Software
application running on a Windows based computer.  Vi-PEC Tuning Software may be
downloaded from www.ViPEC.com. Note that when new versions of Vi-PEC Tuning
Software are released they are posted on the website and may be downloaded at no cost.
Also note that VX ECUs must be used with the correct version of Vi-PEC Tuning Software.

IMPORTANT!

The VX ECU has on board USB.  

BEFORE connecting the ECU to your laptop, the USB drivers must
be installed.  Failure to install the drivers on your laptop first may

result in windows assigning incorrect drivers.  These drivers will not
work with the VX ECU and are difficult to uninstall.

5.1 Installing USB Drivers

Before connecting the ECU to your laptop or PC, the ECU USB drivers must be installed. 
These drivers are installed as part of Vi-PEC Tuning Software Tuning Software installation
as described in the following section.  Should internet download not be practical, a copy of
the drivers on CD can be obtained from your nearest Vi-PEC dealer.

5.2 Installing Vi-PEC Tuning Software Tuning Software

Due to the frequent updates Vi-PEC Tuning Software Tuning Software is no longer shipped
with each ECU.  You will be required to download the latest version of Vi-PEC Tuning
Software Tuning Software from: www.ViPEC.com

Should access to an Internet connection be impractical, the latest version of Vi-PEC Tuning
Software Tuning Software can be requested from your nearest Vi-PEC dealer on CD.

Installing from the web

1. Go to the above website and navigate to the downloads and software updates
section.

2. Download the latest version of Vi-PEC Tuning Software.  When prompted to run or
save the file, select save.  It is recommended to save this file on the desktop.

3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes.  This may take some time.
5. When installed, open Vi-PEC Tuning Software by double clicking on the icon that has

been placed on the desktop.

Installing from a CD

1. Insert the Vi-PEC Tuning Software disk into you computer’s CD ROM drive.
2. Open 'My Computer'
3. Double click your CD ROM drive.
4. Double click the file labelled Vi-PEC Tuning SoftwareSetup.exe (or similar name).
5. Follow the on screen instructions.
6. When prompted to install USB drivers, select yes.  This may take some time.
7. When installed, open Vi-PEC Tuning Software by double clicking on the icon that has

been placed on the desktop.
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5.3 Communicating With Your ECU

After Vi-PEC Tuning Software installation, you will be able to connect  the VX ECU to the
laptop to perform set-up and tuning work.

1. Connect the ECU to your laptop using a Vi-PEC VX ECU USB Cable.  If not supplied
with the ECU, these can be purchased from a Vi-PEC dealer.  No other adapter or
cabling is required.  Connect the cable to the connector labelled USB.

2. If this is the first time you have connected a VX USB ECU to you laptop follow the
driver installation instructions that appear.  When prompted if you want to install
drivers select 'Continue Anyway'.

3. Start Vi-PEC Tuning Software by double clicking on the Vi-PEC Tuning Software icon
on the windows desktop.

4. Switch the key to the ON position.  This will provide power to the ECU.
5. In Vi-PEC Tuning Software, under the 'Options' menu, select 'Connection'.  The

connection options dialogue will open.  Select the correct COM Port number from the
drop down list or select auto for automatic com port detection.

6. Vi-PEC Tuning Software offers both mouse and keyboard control. To establish a
connection between the PC and ECU using the mouse, click the ‘L’ icon located near
the top centre of the Vi-PEC Tuning Software screen.   Alternatively, using the
keyboard, press and hold the Ctrl, Shift and L keys.  The same process can be used
to disconnect.  If a successful connection is established, Vi-PEC Tuning Software will
download settings from the ECU, otherwise you will be warned that an error has
occurred.

7. Make sure the connection shows “ONLINE” in the top right corner of Vi-PEC Tuning
Software.   The logo should also be spinning in the top right corner.  

8. To permanently STORE any changes made to the ECU click on the 'S' icon near the
top centre of the screen or press F4.  If this is not done before turning the ECUs
power off all changes made will be lost.
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6 Pre-Start Configuration

Before starting the vehicle, important pre-start configurations need to be made.

6.1 Firmware Version

It is recommended that the you Vi-PEC VX ECU is running the most up to date firmware.
Firmware version information can be obtained by connecting to the ECU with  Vi-PEC
Tuning Software and selecting 'ECU Information' under the Help menu.

The latest firmware can be downloaded from our website with Vi-PEC Tuning Software. 

It is recommended that this is performed by an experienced Vi-PEC dealer as new features
may need to be properly configured.

The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu
in Vi-PEC Tuning Software. Follow the on screen instructions to complete the firmware
update process.

6.2 Base Configuration

All VX Plug-In ECUs are shipped with base configuration settings.   Note that these are
provided to reduce initial setup and tuning times.  They are NOT recommended tuning
values.  Vi-PEC Tuning Software includes base configurations for various models.
Download the appropriate base configuration into your ECU with Vi-PEC Tuning Software by
connecting to the ECU (described in the Connecting To Vi-PEC Tuning Software section of
this manual), then selecting 'Open' under the 'File' menu.  Select the appropriate .pcl file and
then select 'Open'.  Downloading large configuration files can take up to a few minutes.  Be
patient and acknowledge any messages Vi-PEC Tuning Software shows.

6.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should
always match the Barometric Absolute Pressure (BAP) Sensor.  As well as providing altitude
correction, the BAP sensor also allows the MAP sensor to be calibrated prior to tuning.

Vi-PEC VX ECUs use an on-board barometric sensor that is calibrated prior to dispatch.
This ensures that all Vi-PEC Tuning Software Tuning Software programs (pcl Files) give a
consistent state of tune throughout the ECU range.  This allows a PCL file to be transferred
between VX based ECUs giving an equivalent state of tune providing all factors affecting
volumetric efficiency are equal.

Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor
there would be significant affects on the accuracy of the resulting tune, especially when
tuning with Manifold Gauge Pressure (MGP) as a load index.

To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using Vi-PEC Tuning
Software.

2. Under the Analog Channels menu, select the An Volt channel that has been wired to the
MAP sensor.  Select the correct MAP Sensor Type.

3. Under the 'Options' menu, select 'MAP sensor calibration'.

4. Follow the on screen instructions.
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5. Select the 'Analog Inputs' tab in the runtime values section of Vi-PEC Tuning Software
(lower part of the screen).

6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).

7. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.4 TPS Calibration

The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine
management parameters used by functions such as idle speed control,acceleration
enrichment and motor sport features.  It is important that the ECU knows when the throttle is
open and closed (or part way in between).  The following procedure calibrates the ECU to
match the TPS:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using Vi-PEC Tuning
Software.

2. Under the Analog Channels menu, ensure that An Volt 3 is set to 'TPS (Main)'.

3. Under the 'Options' menu, select 'TPS calibration'.

4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section of Vi-PEC Tuning Software
(lower part of the screen).

6. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when
fully open.

7. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.5 IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and
fitted to the intake system.  It is important that the ECU is calibrated to match the sensor
installed in the engine. This procedure is as simple as selecting the correct sensor type as
follows:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using Vi-PEC Tuning
Software.

2. Click on 'Analogue Channel' in the configuration tree.

3. Select the An Temp channel the sensor has been wired to.

4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.

5. Select the correct 'Temp Sensor Type'.

6. Select the 'Analog Inputs' tab in the runtime values section of Vi-PEC Tuning Software
(lower part of the screen).

7. Ensure that IAT reads the correct temperature.

8. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.6 Input and Output Setup

As the Vi-PEC VX Plug-In ECUs are designed to run several models there are a few items
that must be set-up to make the ECU specific to your model. 
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The Pin Functions section of this manual gives a list of the functions of each channel based
on the target vehicle.

It is the tuners responsibility to make sure that the following channels are set-up correctly for
the vehicle model the ECU is fitted to:

All Auxiliary Output Channels 

Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.

All Digital Inputs

Look at the Digital Inputs runtime values (lower section of the Vi-PEC Tuning Software
screen) to confirm each channels operation.

All Analogue Volt and Temperature Inputs

Look at the Analogue Inputs runtime values (lower section of the Vi-PEC Tuning Software
screen) to confirm each channels operation.

6.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous
sections have been completed.  Only after all pre-start checks have been made should an
attempt be made to crank the engine.  The following steps must be performed before an
attempt is made to start the engine to ensure the VX ECU is calibrated to precisely measure
engine position.

1. Connect the ECU to Vi-PEC Tuning Software.

2. Select 'Fuel', then 'Fuel Set-up':

a. Set ‘Injection Mode’ to OFF.  This will prevent the engine from trying to start while the
triggers are calibrated.

b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU
is lost.

3. Click on ‘Triggers’ then ‘Calibrate Triggers’.

4. Perform the correct trigger calibration procedure specific to your vehicle as described in
the Vi-PEC Tuning Software Tuning Software online help (Press F1).

Note that trigger calibration must be performed again once the engine is running.  Due to the
acceleration and deceleration of the crankshaft at low speeds, an inaccurate measurement
of engine timing is usually made.  Also it is often harder to see timing marks with a timing
light at slow engine speeds.  Trigger calibration should be checked again at between
2000-4000 RPM where engine speed is stable and a more consistent timing reading can be
obtained.
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7 First Time Startup

After performing all set-up instructions given in previous sections, including trigger
calibration, the engine is now ready to be started.  The following procedure should be used
for first time start-up.

1. Turn the ignition key OFF then ON.  The fuel pump should prime momentarily upon power
up.

2. Connect the ECU to Vi-PEC Tuning Software.

3. Click on each of the runtime value tabs (located about two thirds of the way down the
screen) and check that all values are as expected. Where possible operate sensors (e.g.
TPS) to ensure correct readings are displayed.  The following values should be checked:

a. TPS – spans from 0 to 100% when throttle is pressed.  If not, perform a TPS
Calibration.

b. MAP – should read approx 101 kPa (at sea level) with the engine not running.  If not,
check the MAP Sensor Type setting and perform a MAP Calibration.

c. ECT – should read current engine temperature.

d. IAT – should read current intake air temperature.

e. Digital Inputs – Operate switches connected to any digital inputs while watching the
runtime value to ensure they operate as expected.

4. Rectify any faults found in Step 3.

5. Click on the ‘Fuel’ heading, then ‘Fuel Set-up’:

a. Locate the ‘Master’ setting.  This will need to be adjusted during or just after start-up.

6. Crank the engine until it starts.  Some throttle may be required for first time start-up due to
imperfect tuning.  If necessary adjust the Master setting to enrich/lean the engine
(increase to enrich).

7. If the engine fails to start after several attempts, do not crank it endlessly.  Stop and
determine the problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers  runtime values tab).  If this
value increases during cranking/running then there is a trigger setup fault.  It is not
unusual for this number to count one or two on the first engine revolution.

9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best
possible running.

10.The engine should now be allowed to fully warm up.  It may be necessary to readjust
‘Master’ several times to maintain smooth running.  Don’t forget to keep an eye on engine
temperature.

11.Once the engine is warmed up and running well, perform another trigger calibration
(known “as setting the base timing”).

12.Perform a Store by pressing F4.

7.1 Final Checks

To avoid potential engine damage and wasted time, the adjustments presented in the
following sections must be made before attempting to start the engine.  

For further help on any of the settings discussed below, consult the online Help in the 
Vi-PEC Tuning Software Tuning Software.  Online help can be invoked by pressing F1, or
right clicking any item and selecting ‘What’s this?’.

Pre-set-up Checks

Before attempting to configure the ECU, ensure the following tasks have been completed:
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1. Ensure the ECU and all associated components are connected and correctly
wired/installed.  

2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during
the set-up procedure.

3. Check all oil and water levels are correct.

Connecting to Vi-PEC Tuning Software Tuning Software

   Use the following procedure to establish a connection between your Vi-PEC ECU and
Vi-PEC Tuning Software Tuning Software tuning software.

1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to Vi-PEC Tuning Software Tuning

Software as described in the 'Communicating with your ECU' section of this manual. 

7.2 Essential Tuning Adjustments

It is assumed that at this stage all set-up procedures described in previous sections have
been completed and the engine is running.  The following steps detail correct set-up
procedures for some of the more critical ECU parameters (note that MAP Sensor Calibration
should have already been completed by now):

Injector Voltage (Dead-time) Correction

There is always a delay between the injector being energised and the injector actually
opening.  Likewise, there is a small delay between the injector being de-energised and the
injector closing.  The opening time is considerably longer than the closing time, however the
overall result is that less fuel will flow for a given pulse width than would be expected with an
'ideal injector'.  To compensate for this the injector pulse widths are increased to
compensate for this 'dead-time'.  The dead-time for a given injector is a function of the
battery voltage, differential fuel pressure and the type of injector driver (saturated or peak
and hold).  A typical dead-time at 3 Bar differential fuel pressure and 14 volts is just under
1ms (ms = millisecond = 1 thousandth of a second). 

In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the
differential fuel pressure (difference between manifold pressure and fuel pressure) will be
constant.  Therefore the only variable that is changing will be the battery voltage (this
changes with electrical load and sometimes engine speed).  Without correction, the changes
in dead-time will cause the engine to run lean when the voltage drops.  If the Injector
Voltage Correction is properly set-up then changes in the battery voltage will not affect the
air/fuel ratio.

The injector dead-time table allows the dead-time for different battery voltages to be
entered.  The values represent the dead-time in milliseconds.  These should increase with
falling system voltage.

Injector dead-time for a particular set of injectors can be determined using a flow bench or
on a running engine.  

To determine the injector dead-time using a flow bench, the injectors need to be operated at
the intended operating pressure (normally three bar) and at a constant duty cycle as well as
a set voltage.  Vary the supply voltage to the injector and measure minimum pulse width at
which the injectors will flow for a particular voltage.  This is the required dead-time for that
injector at that tested voltage. 

To determine injector dead-time on a running engine, with the engine fully warmed and
operating at stable air/fuel ratios (a very precise AFR meter is required – a narrow band O2
sensor will not suffice), electrical drain needs to be applied to the system; the preferred
method is disconnecting the alternator main fuse.  Battery load testers are also useful here
too.
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Watching the air fuel ratios change while the battery voltage drops, the dead-time table can
be trimmed to maintain the same stable air/fuel ratio.  Injector dead-time can be viewed as a
row graph.  A smooth curve needs to be maintained at all times.

NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector
dead-times.

Master

Master should be set so that the numbers in the middle of the fuel table end up around a
value of 50.  This is to allow sufficient span of the numbers in the main fuel table.
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8 Pin Functions

A list of pin functions is provided, this is useful when configuring your ECU through Vi-PEC
Tuning Software.

8.1 Mitsubishi Lancer Evolution IV - VIII

EVO IV, V, VI EVO VII, EVO VIII

Auxiliary Outputs

Aux 1 Engine Fan (Low Speed) Engine Fan (PWM)

Aux 2 I/C Spray Relay I/C Spray Relay

Aux 3 Tacho Tacho

Aux 4 Wastegate Solenoid Wastegate Solenoid

Aux 5 ISC Stepper ISC Stepper

Aux 6 ISC Stepper ISC Stepper

Aux 7 ISC Stepper ISC Stepper

Aux 8 ISC Stepper ISC Stepper

Aux – Ignition Outputs

Aux – Ign 3 A/C Clutch A/C Clutch

Aux – Ign 4 Engine Fan (High Speed) -

Aux – Injection Outputs

Aux - Inj 5 FP Relay FP Relay

Aux - Inj 6 FP Speed Relay FP Speed Relay

Aux - Inj 7 CE Light CE Light

Aux - Inj 8 Main Relay Main Relay

Analog Channels

An Volt 1 - MAP Signal

An Volt 2 AFM Signal AFM Signal

An Volt 3 TPS Signal TPS Signal

An Volt 4 Oxy Signal Oxy Signal

An Volt 5 P/S Switch P/S Switch

An Volt 6 Expansion Connector Expansion Connector

An Temp 1 ECT ECT

An Temp 2 IAT (AFM) IAT (AFM)

An Temp 3 - Fuel Temperature Sensor

Digital Inputs

DI 1 Ignition Switch Ignition Switch

DI 2 Start Signal Start Signal

DI 3 - I/C Spray Sw (Manual)

DI 4 Vehicle Speed Vehicle Speed

DI 5 - I/C Spray Sw (Auto)

DI 6 A/C Request A/C Request
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9 Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the
ECU (wire side).

9.1 Mitsubishi Lancer Evolution IV - VIII

Pin ECU Function Pin ECU Function

1 Injection 1 55 Aux 2 (Jumper EVO 4-7)

2 Injection 3 57 Aux 2 (Jumper EVO 8)

4 Aux 5 58 Aux 3

5 Aux 7 71 DI 2

8 Inj 5 72 An Temp 2

10 Ignition 1 73 An Volt 1

11 Aux 4 76 An Volt 4

14 Injection 2 77 An Temp 3

15 Injection 4 82 DI 1

17 Aux 6 83 An Temp 1

18 Aux 8 84 An Volt 3

20 Aux - Ign 4 86 DI 4

21 Aux 1 90 An Volt 2

22 Ignition 3 91 DI 3

12 +14V Main Relay 13 Ground

23 Ignition 2 92 Sensor Ground

32 Aux – Ign 4 Other Connections

34 Aux – Ign 4 Expansion 1 Signal Ground

35 Aux – Ign 5 Expansion 2 +5V Out

36 Aux – Inj 7 Expansion 3 DI 7 N/C

37 An Volt 5 Expansion 4 DI 8 N/C

38 Aux – Inj 8 Expansion 5 An Volt 6

39 Aux – Inj 6 Expansion 6 An Volt 7

44 DI 5 Expansion 7 Temp 4 N/C

45 DI 6 Expansion 8 N/C
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10 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often
variations that have not been tested. For this reason issues can arise. Please contact your
nearest Vi-PEC dealer when suspecting a compatibility issue.

10.1 Mitsubishi Lancer Evolution IV - VIII

There are currently no known issues.
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